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 โปรแกรม SXA51.exe คือ โปรแกรมแอสเซมเบลอรชนิดหนึ่งที่ทําหนาที่แปลภาษาแอสเซมบลีให
เปนรหัสคําสั่ง ( Opcode ) แบบ “ Intel Hex Format ” หรือ HEX file นั้นเอง ซึ่งรองรับไมโครคอนโทรลเลอร
ตระกูล MCS-51  
 

 เนื้อหาภายในคูมือฉบับนี้จะแบงออกเปน 4 สวน คือ 1. การติดตั้งโปรแกรม SXA51.exe, 2. การใช
งานโปรแกรม SXA51.exe ในโหมด Comman Line , 3. การใชงานโปรแกรม SXA51.exe บน Windows 
ผานโปรแกรม EditPlus ซึ่งผูอานสามารถดาวนโหลดไดจากเวปไซด www.editplus.com หรือดาวนโหลด
จาก www.thaiware.com ซึ่งเปนเวอรชั่น Shareware, 4. ไวยากรณใน SXA51.EXE  ,เพื่อไมใหเปนการเสีย
เวลามาเริ่มตนกันเลย!!! 
 
การติดตั้งโปรแกรม SXA51.exe 
 

 การติดตั้งโปรแกรม SXA51.EXE นั้น ไมมีอะไรยุงยากครับ เร่ิมแรกใหผูอาน Copy ไฟลโปรแกรมซึ่ง
อยูใน CD-ROM ที่ทาง ETT แถมไปกับบอรดทดลองซึ่งอยูในโฟลเดอร ...\Tools\sxa51 โดยให Copy มาทั้ง
โฟลเดอรเลยจากนั้นนําไปวางไวที่ไดร C:\ ( จริงๆ แลวจะวางไวที่ไหนก็ไดครับ ) เทานี้เปนอันเสร็จพิธีครับ..! 
 

 
 

รูปแสดงตําแหนงไฟลที่ติดตั้ง 
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การใชงานโปรแกรม SXA51.exe ในโหมด Comman Line 
 

 การแปลภาษาแอสเซมบลีดวยวิธีนี้ผูอานจะตองทํางานอยูบนโหมด DOS ซึ่งวิธีการเขาโหมด DOS 
นี้ทําไดโดย คลิ๊กที่ปุม Start => Programs => MS-DOS Prompt  
 

 
 

รูปแสดงการเขาโหมด DOS   
 

ข้ันที่ 1 : เมื่อผูอานเขาโหมด Dos เปนที่เรียบรอยแลว จากนั้นใหใชคําสั่ง “CD” เพื่อเขาไปในโฟลเดอรชื่อ 
C:\Sxa51 ( ที่เราวางโปรแกรมไวตอนตน )  
 
 
 
 
 
 
 
 
 
 

C:WINDOWS>CD\ 

C:\>CD SXA51 

ออกทุกหอง 

เขาหอง SXA51 



                  คูมือการใชงานโปรแกรม SXA51          

 ETT CO.,LTD.                                       3                                     WWW.ETT.CO.TH  

 

ข้ันที่ 2 : เมื่อผูอานเขามาในหอง SXA51 ที่อยูในไดร C แลว จากนั้นผูอานตองแนใจวาในหองนี้ไดมีไฟล
โปรแกรมที่ผูอานไดเขียนขึ้น และ ได Save เปนนามสกุลจุด “ASM” เชนในที่นี้ผูเขียนมีไฟลชื่อ P0.ASM อยู
ในหอง C:\SXA51 ( ซึ่งอยูในหองเดียวกันกับตัวโปรแกรม SXA51.EXE Compiler ) จากนั้นผูเขียนจะเริ่ม
แปลโปรแกรมเปนไฟล “ Intel Hex Format ” หรือ HEX file โดยใชคําสั่งดังนี้ คือ 
 
 
 
 
 
 
Option :  
 - L = Make a Listing file (filename.lst) 
 - D = Be verbose 
 - N = Do not make an object (filename.hex) 
 - C = Include a symbol cross reference listing 
 
 Example : กรณีที่ไฟล P0.asm อยูในหองเดียวกับโปรแกรม SXA51.exe 
 
  
 
 
 
 Example : กรณีที่ไฟล P0.asm อยูคนละหองกับโปรแกรม SXA51.exe เชนอยูใน D:\ EXAM 
 
 
 
 
 
ข้ันที่ 3 : เมื่อมาถึงตรงนี้ผูอานจะไดไฟลนามสกุล “ . HEX “ แลวครับ แตยังไมสามารถนําไฟลนี้ไปใชในการ
ดาวนโหลดโปรแกรมได 
 
 

C:\SXA51>SXA51 <Option> FileName.ASM 

เวนวรรค 

ช่ือไฟล ความยามไมเกิน 8 ตัว 
อักษร ( ไมรวมนามสกุล ) 

รายละเอียดอาน 
หัวขอถัดๆ ไป 

C:\SXA51>SXA51 P0.ASM 

C:\SXA51>SXA51 D:\EXAM\P0.ASM 
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ข้ันที่ 4 : ทําการเปดไฟลนามสกุล .HEX ที่สรางขึ้นจากนั้นตอนกอนหนานี้ดวยโปรแกรม Notepad จากนั้น
ใหทําการเลื่อนขอความในโปรแกรม Notepad ข้ึนมา 1 บรรทัด ( เนื่องจากบรรทัดแรกเปนบรรทัดวาง ) 
 

 
 

รูปแสดงการเลื่อนขอความขึ้น 1 บรรทัด 
 

ข้ันที่ 5 : ทําการ Save ไฟลนี้ทับไฟลเดิม, เทานี้ก็เปนอันเสร็จแลวครับ จากนี้ผูอานสามารถนําไฟล HEX นี้
ไปใชในการ ดาวนโหลดลง CPU ไดแลว....@@@ 
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การใชงานโปรแกรม SXA51.exe บน Windows 
 

 การแปลโปรแกรมดวยวิธีนี้ถือวาเปนวิธีที่สะดวกที่สุด เนื่องจากวาผูอานไมตองมานั่งพิมพคําสั่ง
ทุกๆ คร้ังที่มีการ Compile โปรแกรมใหมแตอยางใด โดยใชโปรแกรม EditPlus ในการทํางาน  
 

 โปรแกรม Editplus จัดเปนโปรแกรม Text Editer โปรแกรมหนึ่งที่ถือวาเปนโปรแกรมที่มีความ
สามารถสูง ในการที่ผูอานจะใชในพัฒนาโปรแกรมใดๆ ไมวาจะเปนภาษา C, C++, Java, VHDL, HTML, 
ASP และ อ่ืนๆ แตในที่นี้ผูเขียนจะนํามาใชกับการแปลภาษา Assembly โดยเริ่มแรกผูอานตองไป
ดาวนโหลดโปรแกรมนี้มากอน ( ในที่นี้ทาง ETT ไมมีใหนะครับ ) จากเวปไซด www.editplus.com หรือดาว
โหลดจาก www.thaiware.com ซึ่งเวอรชั่นที่ไดมาจะเปนตัวทดลองใช จากนั้นติดตั้งโปรแกรมใหเรียบรอย 
และ เมื่อเปดโปรแกรมขึ้นมาจะไดหนาตาง ดังภาพดานลาง 
 

 
 

รูปแสดงโปรแกรม Editplus II 
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การปรับแตงคาบนโปรแกรม Editplus II 
 

 เมื่อติดตั้งโปรแกรม Editplus แลว จากนั้นผูอานจะตองทําการกําหนดคาตางๆ ใหถูกตองเสียกอน 
ซึ่งการกําหนดคานี้จะกําหนดเพียงครั้งเดียวเทานั้น หลังจากนั้นโปรแกรมจะจดจําการเซ็ตอัพคาตางๆ ไว 
 
ข้ันที่ 1 : ไปที่เมนู Tools =>Configure User Tools… 

 

 
 

แสดงหนาตาง Preferences ใน Editplus ( ในภาพเปนการกําหนดคาสมบูรณแลว ) 
 

 
ข้ันที่ 2 : กดปุม Group Name… จากนั้นจะมีหนาตาง “ Rename User Tool Group “  ข้ึนมาใหใสชื่อ 
SXA51 ลงในชอง New name: จากนั้นกดปุม OK 

 

 
รูปแสดงการตั้งชื่อกลุม 

 

2 

3 

4 

5 

6 

7 
8 
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ข้ันที่ 3 : กดปุม Add Tool >> จากนั้นเลือก “ Program “  
ข้ันที่ 4 : ใสขอความ “ Compile Sxa51 ” ในชอง Menu text: 
 

 
 

รูปแสดงการกําหนดคาในชอง Menu text 
 

 

ข้ันที่ 5 : กดปุม  ตรงสวนทายของชอง Command: ซึ่งจะทําใหมีหนาตาง Select File ข้ึนมา ใหผูอาน
กําหนด Path ไปที่ C:\sxa51\sxa51.exe แลวกดปุม Open ตามลําดับ 
 

 
 

รูปแสดงการเลือก Path สําหรับไฟลที่จะใชในการ Compile โปรแกรม .ASM 
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ข้ันที่ 6 : กดปุม  ตรงสวนทายของชอง Argument: จากนั้นเลือก “ File Name “ ซึ่งมีความหมายวา
การ Compile จะถึงชื่อไฟลพรอม นามสกุล 

ข้ันที่ 7 : กดปุม  ตรงสวนทายของชอง Initial directory: จากนั้นเลือก “ File Directory “ ซึ่งมีความ
หมายวา สามารถ Compile โปรแกรมจาก Folder ใดก็ได และ เมื่อ Compile แลวจะไดไฟลนามสกุล . Hex 
อยูใน Folder นั้นดวย 
ข้ันที่ 8 : ต๊ิกเครื่องหมายหนาชอง Capture output เพื่อใหการแสดงผลการ Compile ออกทางหนาตาง 
Output Window จากนั้นกดปุม Apply และ ปุม OK ตามลําดับ เทานี้ก็เปนอันเสร็จพิธี...!!! 
 
ตัวอยางการใชงานโปรแกรม 
 

 เมื่อผูอานติดตั้งโปรแกรม และ เซ็ตอัพ คาตางๆ เปนที่เรียบรอยแลว, ในสวนของการใชงานนั้นงาย
มาก ซึ่งอธิบายเปนขั้นตอนไดดังนี้ คือ 
 

ข้ันที่ 1 : เปดโปรแกรม EditPlus II จากนั้นไปที่เมนู File => New => Normal Text จากนั้นจะปรากฎแผน
กระดาษเปลาๆ มาให 1 แผน ซึ่งใหผูอานเขียนโปรแกรมในสวนนี้ 
 

 
รูปแสดงการเปดหนาตางสําหรับเขียนโปรแกรม 
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ข้ันที่ 2 : จากรูปดานบน ถาหนาตางโปรแกรมของผูอานไมมี Output Window ใหไปเปดที่เมนู View => ต๊ิก
เครื่องหมายถูกหนา Output Window จากนั้นเขียนโปรแกรมของผูอานไดตามตองการ เมื่อเสร็จแลวให 
Save นามสกุล “ . asm “  
ข้ันที่ 3 : จากนั้นทําการ Compile โปรแกรมที่เขียนขึ้นโดยไปที่เมนู Tools => Compile Sxa51 หรือ จะใช
วิธีกดปุม Ctrl + 1 ก็ไดไมผิดกติกาครับ ซึ่งถาการ compile ถูกตองผูอานจะไดรับขอความดังแสดงในรูป
ดานลาง 

 

 
 

รูปแสดงการ Compile อยางสมบูรณในหนาตาง Output Window 
 

ข้ันที่ 4 : ถาโปรแกรมของผูอานผิดพลาด, หนาตาง Output Window นี้จะแสดงจํานวน Error และ จะแสดง
คําสั่งที่ Error  
ข้ันที่ 5 : เมื่อถึงตรงนี้ผูอานจะไดไฟลเพิ่มข้ึนมา 1 ไฟล ซึ่งอยูในโฟลเดอรเดียวกับไฟล . ASM ที่ผูอานได
เขียนขึ้น ซึ่งจะมีนามสกุล . HEX  
ข้ันที่ 6 : เปดไฟลนามสกุล . HEX นั้นขึ้นมาโดยใช Icon   หรือ ไปที่เมนู File => Open  
ข้ันที่ 7 : ผูอานจะเห็นบรรทัดบนสุดของไฟลนามสกุล . HEX นั้นวาง 1 บรรทัด จากนั้นใหผูอานนําเคอรเซอร
วางไวหนาสุดของขอความ ( หนา : ) จากนั้นเลื่อนทุกบรรทัดขึ้นมาดวยปุม Backspace  
 

 
 

แสดงการเลือกทุกคําส่ัง 1 บรรทัด 
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ข้ันที่ 8 : จากนั้นกดปุม Save  
 

 
 

แสดงการเลือกทุกคําส่ัง 1 บรรทัด 
 
 

ข้ันที่ 9 : เทานี้เปนอันเสร็จข้ันตอนทั้งหมดแลวครับ จากนั้นผูอานก็นํา Hex file ไปใชในการดาวนโหลด
โปรแกรมไดแลว 
 
 
 
 
 
 
 
 
 
 

 

Note :  ในกรณีที่ผูอานตองการเปดไฟลนามสกุล . asm ขึ้นมา, ผูอานจะไมเห็นไฟลนามสกุล .asm ดังนั้น ใหผูอาน
เลือกชอง Files of type : เปน All files (*.*) 
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ไวยากรณใน SXA51.EXE 
 
 
 
 
 
 

 



 

การพัฒนาโปรแกรมดวย SXA51 -1- WWW.ETT.CO.TH

การเขียนโปรแกรมภาษา Assembly ตามขอกํ าหนดของโปรแกรม “SXA51”

การใชงานโปรแกรม Assembler SXA51.EXE (MCS-51 Assemblers)
สํ าหรับโปรแกรม SXA51.EXE เปนโปรแกรม Assembler ทํ าหนาที่สํ าหรับแปลโปรแกรม ภาษา Assembly ที่อยูในรูปของ

Text Files ใหเปนไฟล แบบ "Intel Hex Format" (Files.HEX) เพื่อนํ าไปทํ าการ Download หรือโปรแกรมใหกับ CPU ตระกูล
MCS51 อีกครั้งหนึ่ง ซึ่งโปรแกรม SXA51 นี้ จะมีรูปแบบ และขอกํ าหนดเฉพาะบางประการ ในสวนที่เปนความสามารถเฉพาะของ
โปรแกรม Assembler เอง เชน วิธีการกํ าหนดสัญลักษณ LABEL วิธีการกํ าหนด คาคงที่ของเลขฐานสิบหก เลขฐานสิบ ฯลฯ ดังนั้น
ในการเขียนโปรแกรม Text File ภาษา Assembly เพื่อนํ ามาใหโปรแกรม SXA51 นี้ ทํ าการแปลใหนั้น จะตองกํ าหนดรูปแบบตางๆ
ใหตรงกับขอกํ าหนดของโปรแกรม SXA51 ตองการดวย

ในการเขียนโปรแกรมที่เปนภาษา Assembly นั้น ตามหลักการเบื้องตนจริงๆแลว เมื่อเราตองการ เรียกใชงานหนวยความ
จํ าหรือตองการกระโดดไปทํ างานในตํ าแหนงใดหรือการเรียกใชงานโปรแกรมยอย ตางๆนั้น จะตองระบุตํ าแหนง Address ที่
ตองการใหโปรแกรมทราบ ซึ่งคาของตํ าแหนง Address ตางๆนั้น ก็จะเปนคาของ ตัวเลขฐานสิบหก ซึ่งลักษณะเชนนี้จะเปนอุปสรรค
ตอการเขียนโปรแกรมและยากแกการ ตรวจสอบโปรแกรมเปนอยางมาก เนื่องจากคาของตัวเลขตางๆที่รวมอยูในโปรแกรมนั้นอาจมี
จํ านวนมาก และยากตอการจดจํ าและแกไข ดังนั้นโปรแกรม Assembler ตางๆ จึงมีการพัฒนารูปแบบใหสามารถ แทนคาตํ าแหนง
Address ตางๆ ดวยสัญลักษณที่เปนขอความได ซึ่งจะเปนการอํ านวยความสะดวกใหกับ ผูเขียนโปรแกรมเปนอยางมากอีกทั้งยัง
สามารถกํ าหนดตํ าแหนง Address ตางๆใหเปนชื่อหรือขอความอื่น ที่สามารถสื่อความหมายไดดีขึ้น เชน เมื่อตองการเรียกใช
โปรแกรมยอย ที่อยูในตํ าแหนง  Address 1000H ซึ่งเปนโปรแกรมยอยทํ าหนาที่ Scankeyboard แทนที่จะใชคํ าส่ัง LCALL 1000H
ก็สามารถใช LCALL SCANKEY แทนได เมื่อนํ าโปรแกรมไปแปลก็จะไดคาที่ถูกตองเชนเดิม เปนตน

สํ าหรับรูปแบบในการเขียนโปรแกรมภาษา Asembly ของ CPU นั้นจะมีลักษณะคลายกัน แตก็ยัง มีความแตกตางกันอยู
บางขึ้นอยูกับขอกํ าหนดและความสามารถของโปรแกรมที่จะใชทํ าหนาที่ในการสั่ง ใหแปลโปรแกรมคํ าส่ังภาษา Assembly ใหเปน
รหัสคํ าส่ัง ซึงนิยมเรียกวาโปรแกรม Assembler ซึ่งมีอยูมาก มายหลายโปรแกรมบางตัวอาจทํ าหนาที่เปน Compiler โดยมีทั้งสวนที่
ใชเขียนโปรแกรม (Text Editor) และ Assembler ในตัวเดียวกันเลย สํ าหรับในการทดลองนี้ขอแนะนํ าใหใชโปรแกรม Assembler
ชื่อ SXA51 ซึ่งใชทํ าหนาที่แปลโปรแกรมไดอยางเดียว การเขียนโปรแกรมตองอาศัยโปรแกรม Text Editor ตัวอื่นชวย เชน
EDIT.COM ของ DOS หรือ SK.COM โดยใชโปรแกรมที่เปน Text Editor ในการเขียนโปรแกรมแลว Save เปนไฟลไว จากนั้นจึงนํ า
ไฟลภาษา Assembly ที่ไดแลวมาใหโปรแกรม SXA51 แปลใหใน ภายหลัง โดยรูปแบบในการเขียนโปรแกรมภาษา Assembly ภาย
ใตขอกํ าหนดของโปรแกรม SXA51 นั้นจะแบง Field ของโปรแกรมออกเปน 4 สวน หลักๆ ดังตอไปนี้

Lable
(สัญลักษณ)

Operation
(คํ าส่ัง)

Operand
(ตัวกระทํ า)

Comment
(คํ าอธิบาย)

ซึ่งในการเขียนโปรแกรมแลวบางบรรทัดอาจมีครบทั้ง 4 Field บางบรรทัดอาจมีเพียง Field เดียว ก็ไดไมแนนอน ขึ้นอยูกับ
ลักษณะและรูปแบบของคํ าส่ังที่นํ ามาใชเขียนในโปรแกรม
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LABEL(ช่ือสัญลักษณ) ในสวนนี้จะมีหรือไมมีก็ได แตถามีจะตองอยูใน Column แรกทางซาย และตัวอักขระตัวแรกของ
LABEL นี้ควรตองชิดขอบซายของหนากระดาษเสมอ สํ าหรับช่ือของ LABEL นั้นสามารถตั้งไดตามความตองการ โดยใชตัวอักษร
พิมพเล็กหรือใหญก็ได ซึ่งจะมีความหมายเหมือนกัน ซึ่งอักขระที่จะสามารถนํ ามาใชตั้งเปน ชื่อ LABEL นั้นตัวอักษรแรกตองขึ้นตน
ดวย A-Z หรือ "_" หรือ "." หรือ "?" เทานั้น ซึ่งตัวอักษรที่สามารถนํ ามาใชตั้งเปนชื่อ LABEL ไดนั้นไดแก A-Z,0-9 และเครื่องหมาย
พิเศษอื่นๆ โดยความยาวของชื่อ LABEL นั้นสามารถตั้งไดสูงสุดไมเกิน 15 ตัวอักษร และตองไมตั้งชื่อ LABEL ใหตรงกับชื่อคํ าส่ัง
หรือริจิสเตอรของ CPU ดวย และชื่อของ LABEL ตองเรียงติดกันหามเวนวรรค โดยชื่อ LABEL นั้นตองปดทายดวยเครื่องหมายโค
ลอน (:) ที่ทายชื่อดวยเสมอ แตโปรแกรมจะไมถือเอา เครื่องหมายโคลอน(:) นี้เปนสวนของชื่อดวย แตตองใสกํ ากับไว เพื่อบงบอกให
โปรแกรม Assembler ทราบวา ชื่อนั้นคือ LABEL ตัวอยางเชน

HERE: NOP
DJNZ R2,HERE

หรือ
here: NOP

DJNZ R2,HERE

ซึ่งในการเขียนโปรแกรมภาษา Assembly สวนมากนั้นจะนิยมกํ าหนด ชื่อ LABEL ไวเฉพาะใน ตํ าแหนงของโปรแกรมที่
ตองการจะกระโดดไปทํ างานหรืออางอิงถึงโดยคํ าส่ังอื่นๆหรืออาจเปนตํ าแหนง เริ่มตนของโปรแกรมยอยตางๆ ที่ตองเรียกใช เพราะ
จะทํ าใหงายตอการจดจํ าและสื่อความหมายไดมากกวา วิธีการที่ใชการกํ าหนดคาตํ าแหนง Address เปนแบบตัวเลขโดยตรง และ
ประการสํ าคัญเมื่อมีการแทรก หรือตัดคํ าส่ังตางๆในสวนหนึ่งสวนใดของโปรแกรมแลว สามารถที่จะนํ าโปรแกรมนั้นไปทํ าการแปล
ใหม ซึ่งโปรแกรม Assembler ก็จะสามารถทํ าการคํ านวณหาคาของตํ าแหนง Address ใหมที่ถูกตองใหไดทันที

OPERATION(คํ าส่ัง)ในสวนนี้จะตองมีอยูในทุกบรรทัดที่เปนโปรแกรมซึ่งใน Field นี้จะใชเขียน คํ าส่ังภาษา Assembly
ของ CPU (Mnemonic Code) เชน MOV  INC ADD SUBB เปนตน โดยคํ าส่ังที่ เขียนขึ้นนั้นในสวนที่เปน Mnemonic เดียวกัน จะ
ตองเขียนใหติดกันดวยหามเวน ถาหากมีการเวนชองวาง โปรแกรมจะถือวาสวนที่อยูดานหลังชองวางของคํ าส่ัง (Menmonic) นั้น
เปนคาของตัวกระทํ า (Operand) ซึ่งจะทํ าใหเกิดความผิดพลาดขึ้นในการแปลโปรแกรม

 OPERAND(ตัวกระทํ า) ใน Field นี้อาจมีหรือไมมีก็ไดขึ้นอยูกับรูปแบบของคํ าส่ัง (Mnemonic ) ที่นํ ามาใชเขียนโปรแกรม
ใน Field ของ Operation ซึ่งในสวน Field ของ Operand นี้จะเปนตัวบงบอก ใหทราบถึงหนาที่การกระทํ าของคํ าส่ัง(Menmonic)วา
จะใหขอมูลหรือตัวกระทํ า(Operand) ใดมากระทํ ากัน ในคํ าส่ังบาง ซึ่งบางคํ าส่ัง เชน RET(Return Fron Subroutine) ก็จะไมจํ าเปน
ตองมีคาของ Operand เขามา เกี่ยวของในคํ าส่ัง แตบางคํ าส่ังอาจมีตัวกระทํ า Operand ในคํ าส่ัง 1 ตัว หรือมากกวา ก็ได ถามี
Operand มากกวา 1 ตัว จะแบงแยกแตละ Operand ดวยเครื่องหมายคอมมา (,) ตัวอยางเชน

CLR   C CLR เปนคํ าส่ัง(Mnemonic)  สวน C เปนตัวกระทํ า (Operand)
MOV   A,R2 คํ าส่ังนี้จะมีตัวกระทํ า 2 ตัวคือ A และ R2
RET เปนคํ าส่ังชนิดที่ไมมีตัวกระทํ า
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COMMENT(คํ าอธิบาย) ในสวนนี้จะมีหรือไมมีก็ไดไมมีผลตอการทํ างานของโปรแกรมที่เขียน ขึ้นแตอยางใดและ
โปรแกรม Assembler จะไมนํ าสวนคํ าอธิบายหรือ Comment นี้ มาเกี่ยวของกับการแปล โปรแกรมดวย ซึ่งสวนคํ าอธิบายนี้จะนิยม
เขียนกํ ากับไวในโปรแกรมเพื่อใชเปนคํ าอธิบายความหมายกันลืม เพื่อประโยชนในการกลับมาแกไขโปรแกรมเดิมที่เขียนไวนานแล
วจะไดสามารถเขาใจไดโดยงาย โดยคํ าอธิบายนี้จะสามารถเขียนไดยาวเทาไดก็ไดไมจํ ากัด เพียงแตมีขอแมวา ถาเขียน Comment
นี้อยูใน บรรทัดเดียวกับคํ าส่ัง จะตองเขียนใน Column สุดทายหลังจากจบรูปแบบของคํ าส่ังที่เขียนขึ้นแลว

โดยกอนเริ่มตนเขียนสวน Comment นี้ตองใสเครื่องหมายเซมิโคลอน (;)  นํ าหนาไวดวยเสมอ และหามไมให ใส
Comment ไวหนาคํ าส่ัง เพราะโปรแกรม Assembler จะถือวาขอความที่อยูตามหลัง เครื่องหมาย เซมิโคลอน (;) เปน Comment
ทั้งหมดและจะไมนํ าขอความในบรรทัดนั้นมาแปลอีก

ส ําหรับขอกํ าหนดอื่นๆที่ควรทราบมีดังนี้
     1. การกํ าหนดคาเลขฐาน 16 ใหใชอักขระ H ปดทายคานั้น เชน 7FH และถาคาเลขฐาน 16 นํ าหนาดวย ตัวอักษร A-F ตองใส
เลขศูนยนํ าหนดดวย เชน 0A8H,0FFH เปนตน
     2. การกํ าหนดคาเลขฐาน 2 ใหใชอักขระ B ปดทาย เชน 00000001B
     3. การกํ าหนดคาของรหัส ASCII ของตัวอักขระใดใหอยูในเครื่องหมาย (") เชน "A"
     4. การกํ าหนดคาคงที่(Immediate Data) ใหใชเครื่องหมาย (#) นํ าหนาเลขฐานนั้นๆ เชน  #12H
     5. การไมระบุเครื่องหมายใหกับตัวเลขจะถือวาเปนคาของเลขฐานสิบ เชน 5 หรือ 200
ตัวอยางเชน

ตองการกํ าหนดคา 1234 ฐานสิบหก ใหใช   1234H
ตองการกํ าหนดคา 1 ในฐานสอง ใหใช  00000001B
ตองการกํ าหนดรหัส ASCII ของตัว A ใหใช  "A" (คารหัส ASCII ของ A = 41H)
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ตัวอยางโปรแกรม ภาษา Assembly เชน

Label Operator Operand Comment

PORT_A EQU 0E000H ; Port A of 8255
PORT_CTL EQU 0E003H ; Port Control of 8255

ORG 2200H
MAIN: MOV DPTR,#PORT_CTL

MOV A,#80H ; All  Port = Output
MOVX @DPTR,A

LOOP1: MOV DPTR,#TAB_LED ; Table Data
MOV R2,#8

LOOP2: CLR A
MOVC A,@A+DPTR
PUSH DPH
PUSH DPL
MOV DPTR,#PORT_A
MOVX @DPTR,A
POP DPL
POP DPH
LCALL DELAY
INC DPTR
DJNZ R2,LOOP2
SJMP LOOP1

จากตัวอยางโปรแกรมที่แสดงขางตน จะเห็นไดวาลักษณะการเขียนโปรแกรมภาษา Assembly นั้น ไมจํ าเปนตองเขียนให
ครบทุก Field สวนจะมีกี่ Fieldในแตละบรรทัดคํ าส่ังนั้น ขึ้นอยูกับขอบังคับของคํ าส่ัง และความตองการของผูเขียนเปนหลัก จากตัว
อยาง MAIN LOOP1 และ LOOP2  เปน Label Address ใชกํ ากับไวในโปรแกรมเพื่อการอางถึงตํ าแหนงของคํ าส่ังในบรรทัดนั้นๆ
ซึ่งจะเห็นวา MAIN ไมมีการอาง ตํ าแหนงในโปรแกรมเพื่อใชงานเลย แตกํ าหนดไวใหทราบวาเปนตํ าแหนง Address ของโปรแกรม
หลัก สํ าหรับในสวนของตัวกระทํ า Operand นั้นบางคํ าส่ังจะไมมี เนื่องจากเปนขอกํ าหนดของคํ าส่ังนั้นๆเอง และในสวนของ Field
Comment นั้นจะมีหรือไมมีก็ไดแตในโปรแกรมจะใสไวบางจุดในโปรแกรม เพื่อใช เปนคํ าอธิบายความหมายบางอยางกันลืม เชน
ในบรรทัดที่2 ของโปรแกรม(MOV A,#80H) จะใส Comment ไวเพื่ออธิบายวานํ าคา #80H ที่กํ าหนดใหริจิสเตอร ACC นั้นเปนคา
สํ าหรับกํ าหนดให 8255 ทํ าหนาที่เปน Output Port ทั้งหมด เปนตน สํ าหรับคํ าส่ัง EQU และ ORG นั้นจะเปนคํ าส่ังเทียมใชกํ าหนด
คาใหกับ สัญลักษณ Label ตางๆ เพื่อความสะดวกในการเขียนโปรแกรม โดยไมจํ าเปนตองมาจดจํ าคาเปนตัวเลข ใหยุงยาก ซึ่งจะ
กลาวอธิบายถึงในลํ าดับตอไป
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คํ าสัง่เทียมในโปรแกรม Assembler SXA51
ในการเขียนโปรแกรมภาษา Assembly นั้นจะมีความยุงยากกวาโปรแกรมภาษาสูงอื่นๆพอสมควร โดยเฉพาะอยางยิ่ง

เมื่อตองมีการใชพื้นที่ของหนวยความจํ าสํ าหรับเก็บขอมูลชั่วคราวไวกอน  เมื่อตองการ เรียกขอมูลออกมาใชจะเปนการยุงยากอยาง
มาก วาตํ าแหนง Address ใดถูกจัดสรรหนวยความจํ าไวสํ าหรับ เก็บคาของอะไรบาง และยังอาจเกิดความสับสนเรียกใชผิด
ตํ าแหนงได ทํ าใหเกิดความผิดพลาดขึ้นไดงาย ดวยเหตุนี้โปรแกรมที่ทํ าหนาที่เปนตัว Assembler  ตางๆ จึงมีการคิดคนสรางคํ าส่ัง
อีกกลุมหนึ่งขึ้นมาใหม เพื่ออํ านวยความสะดวกใหกับผูเขียนโปรแกรม โดยกลุมคํ าส่ังดังกลาวนี้นิยมเรียกกันทั่วไปวา "คํ าส่ังเทียม"
ซึ่งคํ าส่ังเทียม นี้จะไมใชคํ าส่ังสํ าหรับส่ังงาน CPU แตจะถูกนํ ามาใชเพื่อบงบอกใหโปรแกรม Assembler ไดทราบถึงส่ิงที่จะกํ าหนด
ขึ้น เพื่อนํ าไปใชในการแปลโปรแกรมเทานั้น

ORG (Origin) เปนคํ าส่ังเทียม ใชระบุคาตํ าแหนง Address เพื่อบงบอกใหโปรแกรม Assembler ไดรับรูวา
สัญลักษณหรือคํ าส่ัง ที่เขียนตอจากคํ าส่ัง ORG นั้นจะมีคาตํ าแหนง Address เริ่มตนตามคา ที่กํ าหนดไวจากคํ าส่ัง ORG นี้และคา
Address นั้นจะตอเนื่องกันไปเรื่อยๆ  เชน

ORG 0000H
MAIN: MOV SP,#128-32 ; Define Stack Internal RAM

MOV R2,#0FFH
DJNZ R2,$ ; Power-On Delay

EQU (Equate) เปนคํ าส่ังเทียมใชสํ าหรับกํ าหนดคาใหกับ  ตัวแปรสัญลักษณ(Symbol) ที่กํ าหนด ไวหนาคํ าส่ัง EQU โดย
โปรแกรม Assembler จะถือเอาคา ของตัวแปรสัญลักษณ นั้นๆ ใหมีคาตามที่ กํ าหนดไวหลังคํ าส่ัง EQU ตลอดไปในการแปลคํ าส่ัง
ดังนั้นทุกๆครั้งที่มีการอางถึง ตัวแปรสัญลักษณ ตัวนั้นๆเมื่อใด ก็จะมีความหมายเหมือนกับการอางถึงคาที่กํ าหนดใหทุกประการ ตัว
อยางเชน

PORT_A EQU 0E000H
PORT_B EQU PORT_A+1
PORT_CEQU PORT_A+2

จากตัวอยางการใชคํ าส่ัง EQU ที่ผานมานั้น ในทุกๆตํ าแหนงของโปรแกรมที่มีการอางถึง PORTA ก็จะมีความหมาย
เหมือนกับอางถึงคา 0E000H เสมอ สวนคาของ PORT_B และ PORT_C ก็จะมีคาเปน 0E001H และ 0E002H ตามลํ าดับ ถามีการ
เปล่ียนแปลงคาของ PORT_A เปนคาอื่นก็จะสงผลให PORT_B และ PORT_C ถูกเปล่ียนแปลงคาตามไปดวย เราสามารถใชคํ าส่ัง
EQU กํ าหนดคาใหกับ Symbol Name หนึ่งๆไดเพียงครั้งเดียว เทานั้นในโปรแกรม ซึ่งลักษณะของคํ าส่ัง EQU จะเหมือนกับการ
กํ าหนดคา Constant ในภาษาสูงนั่นเอง
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DB(Define Byte) เปนคํ าส่ังเทียมใชสํ าหรับกํ าหนดคาขอมูลคงที่ขนาด 8 บิต(Byte) ไวในโปรแกรม โดยคํ าส่ังนี้จะถูกนํ า
มาใชประโยชนในการกํ าหนด ตาราง TABLE ตางๆ ที่จะนํ ามาใชใน โปรแกรมโดย จํ านวนขอมูลแตละคาจะถูกแบงแยกออกจากกัน
ดวยเครื่องหมายคอมมา (,) ตัวอยางเชน

TAB_LED: DB 00000001B
DB 02H,04H,08H

TAB_MSG: DB "ABC",00H

จากตัวอยางที่ผานมาเมื่อส่ังใหโปรแกรม Assembler แปลโปรแกรมแลว ที่ตํ าแหนง Address ของ TAB_LED จะมีคาคงที่
อยู 4 ไบท คือ 01H,02H,04H และ 08H เรียงตอเนื่องกันไป สวน TAB_MSG จะไดคาเปนรหัส ASCII ของตัวอักษร ABC เรียงกันไป
คือ 41H,42H,43H และปดทายดวย 00H

DW(Define Word) เปนคํ าส่ังเทียมสํ าหรับส่ังกํ าหนด คาคงที่ ขนาด 16 บิต(Word) โดยตองกํ าหนด คาของ Byteตํ่ ากอน
แลวตามดวย Byte สูง และแบงแยกขอมูลแตละ Word ดวยเครื่องหมาย คอมมา(,)

DS (Define Storage) เปนคํ าส่ังเทียมใชสํ าหรับสงวน หรือ จองพื้นที่ของหนวยความจํ าไว เทากับ จํ านวนที่ระบุไวหลังคํ า
ส่ัง DS เชน

ORG 0000H
DSP_BUFF: DS 4

จะเปนการบอกใหโปรแกรม Assembler ไดทราบวา Symbol ชื่อ DSP_BUFF นั้น ถูกกํ าหนดให มีขนาดของหนวยความ
จํ า 4ไบท โดยมีตํ าแหนง 0000H-0003H ซึ่งถามีการอางถึง Symbol นี้ในโปรแกรม ก็จะมีความหมายเหมือนกับการอางถึงคา
ตํ าแหนง Address 0000H-0003H ดวย โดยถาใชการอางแบบ 8 บิต เมื่อตองการใชตํ าแหนงที่ 2 ของ Symbol อาจใชรูปแบบเปน
DSP_BUFF+1 แทนก็ได ซึ่งจะเปนประโยชน มากในการเขียนโปรแกรมเพราะสามารถสื่อความหมายถึงหนาที่ของหนวยความจํ าได
ดีกวาการอางเปนคา ตัวเลข และยังงายตอการเปลี่ยนแปลงแกไขตํ าแหนง Address ในหนวยความจํ าดวย

END เปนคํ าส่ังเทียมสํ าหรับบอกให Assembler ทราบวาสวนของโปรแกรมทั้งหมดสิ้นสุดลงกอน หนาตํ าแหนงของคํ าส่ัง
END นี้ ซึ่งตองมีคํ าส่ังนี้ไวทายของโปรแกรมเสมอ และหากเขียนโปรแกรมตอหลัง จากคํ าส่ัง END นี้แลว ASsembler จะไมแปล
สวนที่ตอจาก END นี้ใหเลย
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การสัง่แปลโปรแกรมดวย SXA51

สํ าหรับวิธีการเรียกใชงาน โปรแกรม Assembler SXA51 เพื่อใหทํ าหนาที่แปลโปรแกรมภาษา Assembly ที่เขียนไวแลวให
เปน File แบบ "Intel HEX Format" (HEX) มีรูปแบบดังนี้

SXA51  <Option> FILENAME.ASM

Option เปนสวนของขอกํ าหนดในการสั่งแปลโปรแกรม โดยใชเครื่องหมาย "-" นํ าหนาตัวอักษร ที่แทนคาของ Option โดย
เครื่องหมาย "-" และตัวอักษรแสดง Option ตองพิมพติดกัน โดยสามารถใชคา Option มากกวา 1 คาไดในเวลาเดียวกัน  สํ าหรับคา
ตัวอักษร ในการกํ าหนด Option มีดังนี้

-L หมายถึง ใหสราง Listing File ใหดวย โดยจะไดชื่อ Listing File เหมือน Source File แตจะมีสกุล เปน FILE.LST แทน
ซึ่ง Listing File จะมีประโยชนมากในการตรวจสอบ ตํ าแหนงที่เกิดการ Error จากการ Compiler และยังใชอางอิงตํ าแหนง
Address และ Code ของคํ าส่ัง ตางๆไดอีกดวย

-N หมายถึง ใหทํ าการ Compiler โดยไมสรางไฟลใดๆ ใชเพื่อทดสอบวาโปรแกรมที่เขียนขึ้นมีสวน ที่เกิดการ Error  หรือไม
กอนจะสั่ง Compiler  จริง อีกครั้งหนึ่ง ซึ่งการ Compiler แบบนี้จะทํ าไดอยาง รวดเร็วมาก โดยเฉพาะในกรณีที่ Source Code มี
ขนาดใหญมากๆ หากสั่ง Compiler แบบปรกติ จะใชเวลานาน ทํ าใหเสียเวลา

-C หมายถึง ใหทํ าการ Compiler พรอมทั้งสราง Listing File เชนเดียวกับ -L แตแบบนี้จะไดสวน สัญลักษณ Symbol ตอ
ทาย Listing ไฟลเพิ่มใหดวย ซึ่ง Symbol นี้จะมีประโยชนอยางมาก ในการคนหา ตํ าแหนงตางๆในโปรแกรมโดยอางอิงตาม Label

-D หมายถึง ใหแสดงขั้นตอนการแปลในขณะกํ าลังแปลใหดวย นิยมใหในกรณีที่ Source Code มีขนาดใหญมากๆ และ
เครื่องคอมพิวเตอรที่ใชทํ างานไดชา ซึ่งบางครั้งอาจตองรอเปนเวลานาน จนอาจ เขาใจผิดวาเครื่องคอมพิวเตอร Hang ไปแลว เมื่อ
ใช Option นี้จะทํ าใหทราบวา โปรแกรมกํ าลัง ทํ างาน อะไรอยูในขณะนั้นๆบาง

FILENAME.ASM หมายถึง ชื่อไฟล Source Code ภาษา Assembly ที่ตองการใหโปรแกรม แปลใหซึ่งถาหากเรียกใช
โปรแกรมโดยไมมี Option ใดๆ จะไดไฟลที่แปลเสร็จแลวชื่อเดียวกับไฟลตนฉบับ ทุกอยางแตจะมีสกุลเปล่ียนเปน HEX แทน โดย
สถานะของการแปลโปรแกรมจะแสดงใหเห็นที่หนาจอ PC  ถาทุกอยางถูกตองจะแสดงสถานะเปน  "0 Error" หมายถึงไมมีความผิด
พลาด แตถามีความผิดพลาดเกิดขึ้น จากการแปลแลวจะแสดง ตํ าแหนงที่ผิดพลาดพรอมกับสาเหตุที่ตรวจพบรวมทั้งจํ านวนที่ผิดให
ทราบทาง หนาจอดวย แตถาหากมี การ Error หลายๆที่จนไมสามารถดูไดทางหนาจอแลวก็สามารถสั่งแปลโปรแกรม โดยใหสราง
ไฟล Listing ใหดวยก็ได ซึ่งจะไดไฟลเพิ่มขึ้นมาอีก 1 ไฟล โดยกํ าหนดใน Option คํ าส่ัง โดย ชื่อของไฟลจะเหมือนตนฉบับแตมีสกุล
เปน LST แทน จากนั้น จึงใชโปรแกรม Text Editor เปด File ที่มีสกุล LST ที่เรากํ าหนดไวแลวตรวจสอบหาตํ าแหนงและสาเหตุ ของ
ความผิดพลาดที่แสดงไวใน Listing File เพื่อจะไดทํ าการแกไขตนฉบับใหถูกตองแลวนํ าไปแปลใหม เชน

   C:\> SXA51  TEST.ASM

เปนการสั่งใหโปรแกรม SXA51 แปลไฟลภาษา Assembly ชื่อ TEST.ASM ซึ่งถาไมเกิดความ ผิดพลาดใดๆขึ้นจะไดไฟล
ชื่อ TEST.HEX เพิ่มขึ้นมาอีก 1 ไฟล โดยไฟลที่ไดเพิ่มขึ้นมานี้จะเปนไฟลที่ มีรูปแบบตรงตามขอกํ าหนดของ "Intel HEX " สามารถ
นํ าไปทํ าการ Download ใหกับ CPU ไดทันที
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C:\> SXA51 -L  TEST.ASM 

เปนการสั่งใหโปรแกรม SXA51 ทํ าการแปลโปรแกรมภาษา Assembly ชื่อ TEST.ASM ให พรอมทั้งสรางไฟล Listing ชื่อ
TEST.LST ใหดวย ซึ่งไฟล Listing นี้จะแสดงคาตํ าแหนง Address และ รหัสคํ าส่ังเปนตัวเลข ควบคูไปกับโปรแกรมที่เขียนขึ้นให
ทราบ หรือถาการแปลเกิด Error ก็จะแสดงสาเหตุ และตํ าแหนงคํ าส่ังที่ Error ใหทราบดวย

สํ าหรับในการเขียนโปรแกรมเพื่อทํ าการทดลองกับ CPU MCS51 เบอร P89C51RD2 นั้น ตํ าแหนงเริ่มตน (ORG) ของ
โปรแกรมที่จะเขียนนั้นตองเริ่มตนที่ 0000H เทานั้น ไมสามารถเขียนใหอยูนอกเหนือจากที่ กํ าหนดไว ไดเพราะหลังการรีเซ็ตทุกครั้ง
CPU จะกระโดดมาทํ างานตํ าแหนงแรกที่ 0000H เสมอ โดยสามารถเขียน โปรแกรมไดยาวทั้งหมด 8KByte สวนพื้นที่ของหนวย
ความจํ า RAM สํ าหรับใชงานนั้นจะมีขนาด 256 ไบท โดยมีตํ าแหนงใชงานอยูระหวาง 00H-FFH โดยในการเขียนโปรแกรมนั้น ตอง
ทํ าการจัดสรรหนวยความจํ า สวนนี้เองวาจะใชสวนใดสํ าหรับเก็บขอมูล และใหสวนใดเปนพื้นที่ของ Stack สํ าหรับการทํ างานของ
CPU และไมสามารถใชคํ าส่ัง MOVX ได เนื่องจากการตอวงจรใหกับ CPU จะเปนแบบ Single Chips ไมมีหนวย ความจํ าภายนอก
มาตอรวมดวย ขาของ CPU ทุกขาจะถูกนํ าไปใชทํ าหนาที่เปน I/O Port ทั้งหมด
 ขอใหพึงระลึกไวเสมอวา คํ าส่ังเทียม นี้เปนคํ าส่ังเพิ่มเติมที่โปรแกรม Assembler สรางขึ้นมาเพื่อ อํ านวยความสะดวกให
กับผูเขียนโปรแกรม ซึ่งรูปแบบของคํ าส่ังเทียมตางๆเหลานี้  โปรแกรม Assembler แตละโปรแกรมอาจมีมากนอยไมเทากัน และรูป
แบบในการใชงานคํ าส่ังเทียมตางๆ ก็จะไมเหมือนกันดวย ขึ้นอยูกับขอกํ าหนด ของโปรแกรม Assembler ที่จะนํ ามาใชในการแปล
คํ าส่ังโปรแกรม ดังนั้นในการที่จะ เขียนโปรแกรมแตละครั้งควรศึกษาถึงรูปแบบและขอกํ าหนดของคํ าส่ังเทียมตางๆใหเขาใจเสียกอน
เพื่อที่จะไดเขียนโปรแกรมใหถูกตองตามรูปแบบและขอกํ าหนดที่โปรแกรม Assembler นั้นๆ กํ าหนดไว ตัวอยางเชน เมื่อเขียน
โปรแกรมตามขอกํ าหนดของโปรแกรม Assembler ชื่อ SXA51 แลวนํ าโปรแกรม นั้นไปใหโปรแกรม Assembler ชื่อ CROSS-32 ทํ า
การแปลใหแลว อาจเกิดการ Error ขึ้นเปนจํ านวนมาก เนื่องจากรูปแบบและขอกํ าหนดตางๆของโปรแกรมทั้งสองตัวนี้จะไมเหมือน
กัน โดยผูใชสามารถศึกษาเพิ่มเติมไดจากตัวอยางโปรแกรมตางๆเพื่อประกอบความเขาใจ


